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 Greenpeace’s ‘Guide to Greener Elec-
tronics,’ first launched in August 2006, 
ranks the 18 top manufacturers of per-
sonal computers, mobile phones, TVs and 
games consoles according to their policies 
on toxic chemicals, recycling and climate 
change. 
 
Here are the current, recently revised 
rankings:
7.5 Nokia -- Remains in first place with 
good scores on toxics use reduction, en-
ergy and recycling. 
6.9 Samsung -- Maintains second spot 
with good overall scores, supports strong 
global agreement on climate change. 
6.5  Sony Ericsson -- Holds on to 3rd with 
good scores on toxics use reduction and 
energy. 
5.9 Philips -- Up from 7th to 4th with action on 
responsible recycling policy, but needs to 
extend own recycling program. 
5.7 Toshiba -- Slightly improved score 
with better reporting of recycling rates. 
5.3 Motorola -- Remains behind competitors 
like Nokia and Sony Ericsson on toxics 
use reduction and energy. 
5.1 Sharp -- Needs to improve on e-waste 
criteria and energy efficiency reporting. 
5.1 Sony -- Leaps from 12th to 8th place 
with improvements on chemicals and 
waste policy. 
4.9 Apple -- Up from 11th to 9th , the 
most progressive PC maker on removing 
toxics from product range. Room for im-
provement on e-waste and energy. 
4.9 Panasonic -- Remains in 10th place 
with most points on energy criteria, but 
falls down on e-waste criteria. 
4.7 LG Electronics -- Plummets due to 
penalty point for delaying phase out of 

Apple Moves From 11th to 9th 
Place In Greenpeace’s ‘Guide 
to Greener Electronics’
10.01.09
Charles W. Moore - AppleLinks

toxics. 
4.7 Dell -- Improved score but still has 
penalty point for indefinite delay on tox-
ics phase out. 
4.7 Acer -- Loses points with fewer prod-
ucts exceeding new Energy Star 5 stan-
dard; poor on e-waste recycling criteria.
4.5 HP -- Remains in 14th place but penalty 
point lifted, as HP has recently released 
its first product free of worst toxics. 
2.7 Microsoft -- Slight improvement but 
remains in 15th position with poor scores 
on e-waste and energy. 
2.7 Fujitsu -- Slight improvement but 
needs to do more across all criteria. 
2.5 Lenovo -- No improvement, and still 
has a penalty point for indefinite delay 
on toxics phase out. 
1.4 Nintendo -- Increased score but stays last, 
greenhouse emissions continue to grow.

 Apple finished mid-pack, but is moving 
up and beats all other major personal 
computer manufacturers excapt for 
Toshiba on the greenness scale, at least 
according to Greenpeace based on the 
criteria that companies:
• Clean up their products by eliminating 
hazardous substances. 
• Takeback and recycle their products 
responsibly once they become obsolete.
• Reduce the climate impacts of their 
operations and products.
 The guide is updated every few 
months. The current edition was published 
on September 30, 2009.

 The high-tech industry has been working 
itself into paroxysms of excitement lately 
over an idea that is not exactly new: tablet 
computers.

Just a Touch Away, the Elusive 
Tablet PC
10.04.09 
Brad Stone & Ashlee Vance
New York Times

 Quietly, several high-tech companies 
are lining up to deliver versions of these 
keyboard-free, touch-screen portable ma-
chines in the next few months. Industry 
watchers have their eye on Apple in partic-
ular to sell such a device by early next year.
 Tablets have been around in various 
forms for two decades, thus far deliver-
ing little other than memorable failure. 
Nonetheless, the new batch of devices 
has gripped the imagination of tech ex-
ecutives, bloggers and gadget hounds, 
who are projecting their wildest dreams 
onto these literal blank slates.
 In these visions, tablets will save the 
newspaper and book publishing industries, 
present another way to watch television 
and movies, play video games, and offer a 
visually rich way to enjoy the Web and the 
expanding world of mobile applications.
 “Desktops, laptops — we already know 
how those work,” said Brian Lam, editorial 
director of the popular gadget site Gizmo-
do, which reports and hypothesizes almost 
daily about these devices. Tablets, he said, 
“are one of the last few mysteries left.”
 Tablet computers were first conceived as a 
way to supplant plain old paper, in the same 
way that PCs replaced the typewriter.
 In 1993, Apple’s Newton MessagePad, with 
its expansive screen and stylus pen, became 
known less for its innovative features than for 
being lampooned in “Doonesbury,” which 
ridiculed the device for its flawed handwrit-
ing recognition. Steven P. Jobs killed the 
Newton when he returned to Apple in 1997.
 Then in 2001, at Comdex, the industry 
trade show, Bill Gates introduced new 
Windows software for tablets with a 
bold prediction: within five years, he said, 
tablets “will be the most popular form 
of PC sold in America.” It didn’t happen, 
of course. Tablets running Windows sell 
only a few hundred thousand units a 
year, mostly in business fields like health 
care and financial services.
 There were basic problems with these 
early tablets: they cost too much and did 
not do enough.



4. PowerBook G4
Year released: 2001

CPU: 400/500 MHz PowerPC G4
Original Price: $2,599 to $3,499

Why It’s Important: Like other Apple 
laptops before it, the PowerBook G4’s 
sleek and simple design broke the status 
quo of bulky, bulbous, plastic portables 
that—until then—had dominated the 
marketplace.
 The PowerBook G4 shipped with durable 
titanium case that induced slack jaws and 
drooling in all who wished the company 
of such a beautiful machine. Also, at only 
1-inch thick and completely flat, it was 
Apple’s thinnest laptop at the time.
 The PowerBook G4 line continued to 
push itself to new heights with incre-
mental revisions over the years, but none 
made quite the initial splash as the first 
model released in 2001.

3. iBook
Year released: 1999

CPU: 300 MHz PowerPC G3
Original Price: $1,599

Why It’s Important: The iBook’s radically-
different candy-colored design initially 
overshadowed a much more important 
change brewing beneath the surface: in-
tegrated wireless Ethernet support. The 
iBook shipped with a built-in antenna 
and a slot for an internal AirPort card, Ap-
ple’s implementation of the 802.11b Wi-Fi 
standard—a world’s first for any laptop 
from any manufacturer.
 Apple was the first to step out and 
openly declare that Wi-Fi was the way of 
the future, setting the stage for a broad, 
industry-wide adoption of wireless net-
working in later years. Today, all laptops 
ship with some form of wireless network-
ing support, and it all started with the 
iBook in 1999.

2. PowerBook 520
Year Released: 1994

CPU: 25 MHz MC68LC040
Original Price: $2,270

Why It’s Important: The PowerBook 520 
revitalized the PowerBook brand with a 
number of new features, including built-
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 On the anniversary of the first Mac portable, 
we name the five most significant models
 The Macintosh already enjoyed its silver 
anniversary this year, but it’s not the only 
Mac product to hit a milestone in 2009. 
Twenty years ago this week, Apple in-
troduced its first laptop computer—the 
Macintosh Portable.
 At $6,500 (that’s $11,313 in 2009 dollars), 
16 pounds, and the size of a briefcase, it 
failed to realize the dream of the perfect 
Mac laptop. But a lackluster reception 
didn’t hold Apple back for long. Having 
learned from its mistakes, the company 
rolled out its PowerBook series just two 
years later—a release that offered more 
innovation and influence than Apple’s 
then-low market share would suggest.
 Over the years, many important Mac 
laptops have defined Apple’s course in the 
portable market. Here are five most signif-
icant laptops to come out of Cupertino in 
the last two decades, along with why they 
enjoyed such a lasting influence.

5. MacBook Pro
Year released: 2006

CPU: 1.83/2.0GHz Intel Core Duo
Original Price: $1,999 to $2,499

Why It’s Important: By 2006, the G4 
processor was showing its age, and Mac 
fans nervously fretted about Apple losing 
its edge technologically. The PowerPC G5 
had ruled the Mac desktop for some time, 
but Apple claimed it couldn’t find a way 
to squeeze the hot and power-hungry G5 
chip into a laptop form-factor. The only 
way out for Apple was to switch to Intel 
processors in its laptops, which it did with 
the MacBook Pro in 2006.
 By doing so, Apple unleashed a four-fold 
increase in performance and charted a 
new technological course that would al-
low the company to stay competitive in 
the portable computer space through 
today—and beyond.

The 5 most important 
Mac laptops
09.22.09
Benj Edwards, Macworld.com

in stereo speakers, Ethernet, and 
PC Card slots. But more important, 
it was the first laptop in the world 
to include a touch-sensitive trackpad in 
place of the earlier trackball.
 The trackpad’s central position, similar 
to that of trackballs before it, also set the 
standard that most laptops follow today. 
Overall, Macs proved especially influential 
in laptop pointing devices over their PC 
counterparts due to the fundamentally 
graphical nature of Mac OS, as opposed 
to MS-DOS.

1. PowerBook 100
Year Released: 1991

CPU: 16 MHz MC68HC000
Original Price: $2,500

Why It’s Important: Apple’s PowerBook 
100, along with the 140 and 170, launched 
Apple’s long-lived PowerBook line of lap-
tops, a culturally important brand which 
would dominate Apple’s portable of-
ferings until the switch to Intel CPUs in 
2006. The 100 addressed the three major 
problems critics had with 1989’s Macin-
tosh Portable—size, weight, and price.
 Until the PowerBook series, few laptops 
shipped with built-in trackballs (due to 
the predominance of MS-DOS on com-
peting machines), and none featured 
them in a prominent center-position like 
Apple’s laptops.

 Ecofont.com offers downloads of its Ecofont 
for free. That’s the best deal we’ve seen on 
an environmentally friendly font. This type-
face was designed with tiny “holes” all over 
each letter, which purports to use 20% less 
ink when printing text-only documents. 
It’s compatible with Windows, Mac OS X, 
and Linux.

http://dealmac.com/322272.
html?ref=txt_dealmacdaily

Ecofont
Ecofont download for FREE!! 
dealmac



3

09.22.09
Rob Griffiths, Macworld.com

 Nearly two weeks after taking the wraps off 
iTunes 9, Apple has an update for its music 
jukebox application. iTunes 9.0.1 fixes a num-
ber of issues--the most obvious of which is a 
quick reversal of decision on the functionality 
of the green "maximize" button.
 In iTunes 9, if you wanted the miniature 
iTunes player window, you had to hold 
the Option key while clicking the green 
button. As of iTunes 9.0.1, the pre-iTunes 
9 behavior has returned--clicking the 
green button switches to the miniature 
player mode. (Option-clicking the green 
button now maximizes the window.)
 The update also promises improvements 
to iTunes Store browsing and fixes an issue 
where the application becomes unrespon-
sive or unexpectedly quits. iTunes 9.0.1 also 
resolves a problem syncing podcasts in 
playlists to iPods and iPhones.
 Other changes include a fix for a sorting 
issue that affected albums with multiple 
discs and improvements to application 
syncing for the iPod touch and iPhone.   
 Finally, the Genius feature has been 
set to automatically show Genius Mixes; 
many users had trouble getting Genius 
Mixes to show in iTunes 9.
  The 82.95MB iTunes 9.0.1 update is 
available through Software Update, or via 
Apple's download page.

iTunes 9.0.1 Update 
Restores ‘Maximize’ Button 
Behavior

 Don’t like the idea of your neighbors 
rudely snooping on the wireless signal you 
slaved to pay for from the lazy comfort of 
their living room? It’s not just about slow-
ing down your connection; while they’re 
downloading Mad Men via bittorrent, you 
could be on the hook for their actions.
 Wireless security and encryption systems 
are fraught with problems and insecurity, 

and other methods to restrict your signal to a small area are cumbersome at best.
 Enter a new solution: Anti-Wi-Fi paint.
 The idea is simple: Use a special paint on walls where you don’t want wireless to 
pass through (say the exterior of your house). The secret is mixing aluminum-iron oxide 
particles in with the paint. The metal particles resonate at the same frequency as Wi-Fi and 
other radio waves, so signals can’t pass through the thin layer of pigment. Outsiders would 
simply be unable to access your wireless network, just as you, inside the house, won’t be 
able to interlope on anything beamed on the outside.
 Developed by the University of Tokyo, the paint is said to be the first that can block 
radio frequency in higher spectra where Wi-Fi and other higher-bandwidth communica-
tions occur rather than just low-frequency wireless like FM radio. Most Wi-Fi technolo-
gies operate at 2.4GHz; the Tokyo paint can reportedly block frequencies all the way up 
to 100GHz, with a 200GHz-blocking paint now in the works.
 The paint isn’t just of interest to those concerned about wireless leaking out of the build-
ing. Movie theaters have long been interested in finding a legal way to keep cell phones 
silent during screenings. Electronic jammers that actively block wireless signals are illegal, 
but passive materials that prevent wireless signals from getting through are not. Since the 
wireless-blocking paint can also block the lower-frequency signals that cell phones use, 
addled mobile junkies would have no outlet for reaching the outside world.
 Some aren’t convinced that anti-Wi-Fi paint makes a lot of sense for a secure situa-
tion, though. Says one engineer, “Surely the thought of having to redecorate a build-
ing in order to provide Wi-Fi security is more costly and complex than the security 
functionality available in even the cheapest of Wi-Fi access points...”
 
Good point.

Anti-Wi-Fi paint keeps your 
wireless signal to yourself
09.30.09 Yahoo Tech

TarMac Tips

 If you’re anything like me, you fall into 
certain habits when using programs such 
as Apple Mail—you get used to using the 
same small set of core features all the 
time and tend to overlook capabilities 
that are less obvious, though no less use-
ful. Based on my own experience and my 
observations of several other Mail users, 
I’ve compiled a list of seven truly helpful 
features that often go unnoticed (appli-
cable to both Leopard and Snow Leopard 
versions of Mail).

1. The Photo Browser
 Want to attach an image to an e-mail 
message? Use Mail’s Photo Browser to 

The seven most underused 
Mail features
Joe Kissell, Macworld.com

grab a photo from your iPhoto library 
without launching iPhoto. I can’t tell you 
how many times I’ve wanted to mail 
someone a photo, and my first impulse 
was to launch iPhoto (and then drag an 
image into Mail or use iPhoto’s Share -> 
Email command). But there’s a quicker 
and easier way. In Mail, just choose Win-
dow -> Photo Browser. A floating window 
appears instantly, showing the complete 
contents of your iPhoto library. Locate 
the picture you want, drag it into a mes-
sage window, and you’re done.

2. Plain Text
 This may be a bit of a personal bias, 
but I like to receive e-mail in plain text 
(so that I get to decide what font, size, 
style, and color messages use). I also like 
to extend that courtesy to others. Mail 
uses Rich Text by default for outgoing 
messages, but you can change this by 
choosing Mail -> Preferences, clicking on 
the Composing icon on the toolbar, and 

continued on p.4
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 Tap into this unassuming key’s hidden 
productivity tricks
 Ancient Greek and Latin writings had 
no spaces between words; you just had to 
be familiar with where words started and 
stopped in order to read textlikethis. But 
we should be grateful to the spacebar for 
more than just its sacred word-separation 
calling, because it can also perform quite 
a few tricks in various environments.

1. Play and pause
 In any application that provides Play 
and Pause controls, you can use the 

Five unexpected uses 
for the Spacebar
09.14.09
Sharon Zardetto, Macworld.com

choosing Plain Text from the Message 
Format menu. (To change the format for 
an individual message, choose Format -> 
Make Rich Text or Format -> Make Plain 
Text.) To force incoming mail to display in 
plain text by default (which isn’t possible 
for all messages), you need to quit Mail, 
open Terminal (in /Applications/Utilities) 
and enter the following command: de-
faults write com.apple.mail PreferPlain-
Text -bool TRUE. To switch to styled text 
(if available) when viewing a plain-text 
message, choose View -> Message -> 
Best Alternative.

3. Multiple From addresses
 If an e-mail account has more than one 
valid From address (for example, if you 
use jk@example.com as an alias to joeki-
ssell@example.com), you can configure 
Mail to let you use any of those addresses 
when sending a given message from that 
account. First, choose Mail -> Preferences, 
click on the Accounts icon on the toolbar, 
select your account, and click on Account 
Information. Then, in the E-mail Address 
field, enter all the addresses you might 
use with that account, separated by com-
mas. Close the Preferences window and 
click on Save. Now, when you compose 
a new message, you can choose any of 
those addresses from the From pop-up 
menu below the Subject field.

4. Activity window
 Does Mail seem to take an awfully long 
time to check or send messages? If you’re 
curious to know what it’s up to behind 
the scenes, choose Window -> Activity 
(Command-0) to display a floating win-
dow showing each operation Mail is cur-
rently performing. You can stop any given 
activity by clicking on its Stop icon.

5. Connection Doctor
 If you encounter problems sending or 
receiving mail, you don’t need to guess 
at the nature of the problem. Find out ex-
actly what’s wrong by choosing Window 
-> Connection Doctor. Mail then checks 
each of your incoming and outgoing ac-
count connections, and displays a win-
dow with a plain English description of 
any problems it found, usually with ad-
vice for fixing them.

continued from p.3Mail 6. Send Again
 Suppose you sent a message to a 
bunch of people and you realize you 
forgot someone. Instead of opening the 
message in your Sent mailbox, copying 
its contents, and pasting it into a new 
message, just select the message, choose 
Message -> Send Again (Command-
Shift-D), and replace the existing recipi-
ents with the new one(s). The subject 
and message contents remain the same 
as before (although you can edit them if 
you like).

7. Remove Attachments
 Attachments—whether in messages 
you’ve received or copies of outgoing 
messages in your Sent mailbox—can 
chew up a lot of disk space. If you use an 
IMAP or Exchange account that imposes 
a storage quota, this can become a sig-
nificant concern. Luckily, Mail can remove 
attachments from stored messages, and if 
you’ve already saved a copy of the attach-
ments elsewhere, using this feature is a 
good idea. Locate one or more messages 
with attachments and choose Message -> 
Remove Attachments. Behind the scenes, 
Mail duplicates the message (omitting at-
tachments) and deletes the original.

spacebar to alternately play and 
pause the content. This includes 
movies and slideshows, as well as 
audio-only files such as those you play in 
Apple iTunes and GarageBand.

2. Open spring-loaded folders instantly
 Spring-loaded folders are one of OS 
X’s most-overlooked timesavers. In the 
Finder, drag an item, hover over a folder, 
and after a brief pause (so the Mac knows 
you’re not simply hesitating before drop-
ping the item in) a Finder window springs 
open, revealing the folder’s contents. This 
makes it easy to see that you’re mov-
ing or copying an item into the correct 
place if your folder names are less than 
descriptive. It also simplifies getting into 
subfolders.
 You set the length of the spring-open 
delay in the General pane of Finder -> 
Preferences. Or, avoid the delay altogeth-
er by pressing the spacebar to open a 
hovered-over folder instantly.
 Even if you turn off the spring-loaded 
folders feature by going to Finder -> 
Preferences and deselecting the Spring-
loaded Folders And Windows setting, 
pressing the spacebar still opens a folder 
when you hover over it holding an item 
to drop into it.
 Spring-loaded folders work from the 
Dock, too. Press the spacebar to open 
a folder in the Dock without waiting, 
whether or not spring-loading is turned 
on in the Finder’s preferences.

3. Access screenshot options
 When you need to document some 
aspect of your Mac’s behavior, a screen-
shot of the full screen is seldom necessary. 
Sure, you can press Command-Shift-4 to 
select an area to capture to the Desktop 
(or Command-Shift-3 to save the whole 
screen as a file on the Desktop), but if you 
add the spacebar you’ll access more op-
tions.
 Pressing the spacebar before you drag 
across an area to capture it changes your 
cursor to a camera and lets you select an 
entire window (or a dialog box, or a menu 
without its title) by clicking on it. Press-
ing the spacebar after you’ve dragged a 
selection rectangle—but before you let 
it go—allows you to move the selection 
rectangle around on the screen to adjust 
its position before capturing the shot; let 

continued on p. 5

Spacebar



go of the spacebar with the mouse button 
still down if you want to adjust the size of 
the rectangle after you’ve moved it.

4. Zoom in on windows in Exposé
 One of the more clever feature tweaks in 
Snow Leopard involves the space bar. When 
you invoke Exposé, Mac OS X displays your 
open windows in a grid on your screen, at 
a substantially reduced size. Sometimes it’s 
hard to recognize which window is which 
when you’re in this view, and the window’s 
title isn’t always a good enough clue. Now 
you can use your space bar to zoom in and 
preview your Exposé windows. Just move 
your cursor over a window and press the 
spacebar. If it’s the window you want, press 
Return. If not, you can press the spacebar 
again to zoom back out.

5. “Click” on items using the keyboard
 With All Controls turned on the in Keyboard 
Shortcuts preference pane, tab to a menu 
(the blue halo shows it’s selected) and 
use the spacebar to open it. Use an ar-
row key to highlight a menu choice, and 
then use the spacebar again to trigger 
the command.
 Prefer to move around in dialog boxes or 
Web pages using the keyboard instead of 
the mouse? Select All Controls under Full 
Keyboard Access in the Keyboard Shortcuts 
preference pane (in Leopard’s Keyboard & 
Mouse preferences, or Snow Leopard’s Key-
board preferences). With All Controls active, 
a press of the Tab key selects, in turn, every 
component of whatever you’re working 
in—a dialog box, for example. Once you’ve 
selected a component, press the spacebar 
in lieu of clicking the mouse.
 So, for instance, with All Controls on, 
tabbing around on a Web page includes 
not only the search and other text fields 
on a form, but all its clickable spots, and 
the spacebar “clicks” the selected item.

Five unexpected uses for the 
Option key
 The Option key is the unsung 
hero of the keyboard. Since the 
earliest days of the Mac, it has 
provided access to special font characters; 
revealed alternative commands in menus; 
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continued from p.4 and let you Option-drag to create a copy 

of something, such as a Finder icon or a 
graphic selection (from MacPaint to Pho-
toshop CS4!). Its capabilities have only 
increased with time, so it’s always worth 
pressing Option to modify a click or drag, 
just to see what might happen. Here are 
five of my favorite Option key tricks.
 Most of the time, I use the scrollbar—
for example, in Apple’s Safari or Micro-
soft Word—to move my view a full page 
orscreen at time. (By default, when you 
click on a scrollbar, that’s what it does.) 
But sometimes—in a long document, for 
instance—I know that I want to go to a 
point about three-quarters of the way 
through the document. It’s easier to click 
where I want to go—three-quarters of 
the way down on the scrollbar—than to 
click and drag the scroller to get there.
 You can choose between these actions,
Jump To The Next Page or Jump To Here—
by setting the Click In The Scroll Bar To 
option in the Appearance preference 
pane. Or, have it both ways: Option-click 
in the scrollbar to temporarily reverse the 
setting you’ve made in Preferences. So, if 
your setting is Jump To The Next Page, an 
Option-click in the scrollbar will instead 
jump you to a particular spot.

2. Open preference panes using function 
keys
 You love the convenience of dimming 
or brightening your screen with a quick 
press of F1 or F2, but sometimes you 
need to adjust other aspects of your 
display. For instance, you might want to 
temporarily change the screen resolution 
to test something. Wouldn’t it be nice if 
you could get to the Displays preference 
pane as quickly as you can change the 
screen’s brightness?
 Wish granted! Hold Option while press-
ing either of the function keys that con-
trols brightness, and the Displays prefer-
ence pane opens. This works with other 
function keys, too: hold Option while you 
press any of the volume function keys 
(F3-F5 or F10-F12, depending on your 
keyboard), and the Sound preference 
pane opens. If you have your system set 
up so that you need to press the Fn key to 
trigger the special features on the func-
tion keys (the ones represented by icons), 
then just add the Option key to the mix: 
Fn-Option-F1, for instance.

3. Switch speakers from the menu 
bar
 You need to switch from the in-
ternal speakers to your headphones for 
a Skype call, or you’re the last one in the 
office so you want to blast your iTunes 
playlist through your external speakers. 
If you’re using Snow Leopard, and your 
Volume menu is in the menu bar, you 
don’t have to open the Sound preference 
pane to switch output devices: press Op-
tion before you open the Volume menu, 
and instead of getting the volume slider, 
you’ll see a list of available input and out-
put devices. (To make the Volume menu 
appear in the first place, go to the Sound 
preference pane and select the Show Vol-
ume In Menu Bar option.)

4. Option-click to open multiple
Inspector palettes
 The Macworld article Rule the Office 
notes that you can open multiple Inspec-
tor windows in Keynote and Pages by 
using the View -> New Inspector com-
mand. But this always opens a Document 
Inspector, so you must then click on the 
icon for the Inspector you need. Instead 
of using the menu command, Option-
click directly on an icon in an existing In-
spector palette to open a new Inspector 
for that category.

5. Choose a startup disk when booting
 You’re staring at your blank Mac screen; 
you have two (or more) startup drives 
for your Mac, but you forgot to specify 
the one you want to use in the Startup 
Disk preference pane. You don’t have to 
start up, change the setting, and restart: 
just hold down Option when you turn on 
the Mac and you’ll see available startup 
drives displayed on the screen. Choose 
the one you want and you’re good to go.

Spacebar

Macworld Video Tips: Snow Leopard
 In this week’s Macworld Video, Rob Griffiths 
delves into six Leopard tips that you may or 
may not be familiar with. 
 Why six? Consider it a tribute to the “.6” 
in Snow Leopard’s version number.
 You can watch the 6-minute video -- 
and download it -- at Macworld.com.
http://lm.macworld.com/
t/673895/13040268/16133/0/
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 “Software engineers 
got ahead of the 
hardware capabili-
ties,” said Paul Jack-
son, a consumer 
product analyst at 
Forrester Research. “But we may be finally 
getting to the point where the dreams 
and aspirations of those designers are 
actually meeting capable and reasonably 
priced technology.”
 You can thank Moore’s Law and the im-
mutable advance of technology for that. In-
tegrated microchips now combine wireless 
connectivity and support for features like 
multimedia, GPS functions and rich graph-
ics. They are also more energy-efficient.
 At the same time, the iPhone and its imita-
tors have demonstrated that new tactile touch 
screens work and that people are comfortable 
with them, in a way they never got accus-
tomed to using earlier tablets and stylus pens.
 “We darn well should be about ready to 
take advantage of this stuff. It’s time,” said 
Bill Buxton, a researcher at Microsoft who 
has been working on multitouch systems 
for 20 years, and has a comprehensive 
collection of tablets and touch screens 
he keeps in his office in Toronto.
 The drumbeat of tablet product introduc-
tions has already begun. In June, Archos, a 
French consumer electronics company, be-
gan selling a small touch-screen tablet run-
ning Google’s Android software. Later this 
month, it will introduce another tablet that 
runs on Microsoft’s Windows 7, which has 
built-in support for touch screens.
 “A road warrior doesn’t want to take a big 
clamshell netbook with him,” said Frédéric 
Balaÿ, vice president for marketing at Archos.
 The industry blog TechCrunch has also 
commissioned its own Web tablet, called 
the CrunchPad, which it has said it will 
start selling later this year.
 Despite its past bruises in the tablet busi-
ness, Microsoft appears ready to try again. 
In September, images of a booklike Micro-
soft device called Courier, with two 7-inch 
color screens, surfaced on Gizmodo.
 In an interview, Steve Ballmer, Microsoft’s 
chief executive, would not discuss that 
product in particular, but said the com-
pany devises such prototypes all the 
time, so it can take them to its hardware 
partners. Still, rumors of a Microsoft tab-
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e-mail from some customer who said, ‘I 
want that,’ ” Mr. Ballmer said.
 Apple’s rumored tablet is the most 
highly anticipated of the lot. Analysts ex-
pect Apple to introduce it early next year,  
a sort of expanded, souped-up version of 
the iPod Touch, priced at around $700.
 Last week, Apple rehired the original 
chief marketer of its old Newton, Michael 
Tchao, who was working at Nike. Mr. 
Tchao’s former Apple colleagues believe 
he will help market this new device.
 Colin Smith, an Apple spokesman, de-
clined to comment on the company’s 
recruitment or product plans. But Apple’s 
tablet will most likely have little in com-
mon with the Newton, which was essen-
tially a personal digital assistant. The new 
crop of tablets is being viewed as more 
flexible — gadgets that combine ele-
ments of the iPhone, e-book readers like 
the Kindle and laptops.
 Apple has been working on such a 
Swiss Army knife tablet since at least 
2003, according to several former em-
ployees. One prototype, developed in 
2003, used PowerPC microchips made by 
I.B.M., which were so power-hungry that 
they quickly drained the battery.
 “It couldn’t be built. The battery life 
wasn’t long enough, the graphics perfor-
mance was not enough to do anything 
and the components themselves cost 
more than $500,” said Joshua A. Strickon, 
a former Apple engineer whose name is 
on several of the company’s patents for 
multitouch technology.
 Another former Apple executive who 
was there at the time said the tablets 
kept getting shelved at Apple because 
Mr. Jobs, whose incisive critiques are of-
ten memorable, asked, in essence, what 
they were good for besides surfing the 
Web in the bathroom.
 The success of the iPhone may have 
partially helped to answer that question. 
As of last month, developers had created 
85,000 applications for the iPhone and 
iPod Touch — video games, social net-
working software, restaurant finders and 
more. Analysts believe that all those pro-
grams will immediately work on the new 
tablet while developers begin to tailor 
new software for the larger screen.
 Despite the preponderance of apps, 
there is still the persistent question of 
whether regular people will really find a 

use for tablet computers. Smaller 
cellphones are increasingly multi-
purpose and fit nicely in a jacket 
pocket. And low-end laptops are 
inexpensive, run a full-fledged operating 
system and offer the luxury of a keyboard.
 “I can imagine something like the iP-
hone with a much bigger screen being a 
gorgeous device with great capacity, but I 
don’t know where I would fit that into my 
life,” said a former Apple executive, who 
declined to be named because of Apple’s 
secrecy policies, but who anticipates an 
Apple tablet next year. “Those are the de-
bates that have been happening inside 
Apple for quite some time.”

 Apple has risen in rank on Interbrand’s 
2009 list of Best Global Brands. The com-
pany rises four spots to number 20, and 
is ahead of other electronics companies 
like Sony and Nintendo.
 Coca-Cola, IBM, and Microsoft occupy 
the top three spots. Other top ten entries 
include McDonald’s, Google, Toyota, Disney, 
and Intel. There’s remarkably little change 
in the top 10 compared to 2008. Some po-
sitions have shifted (most notably Google, 
hopping up to 7th place from 10th).

Apple rises in “Best Global Brands” 
ranking
Peter Cohen, Macworld.com


